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Welcome to MicroSim
Welcome to MicroSim’s family of products. Whichever 
programs you have purchased, we are confident that you wi
find they meet your circuit design needs. The purpose of the
products is to provide an easy-to-use environment for creati
and implementing your circuit designs from start to finish. 
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All registered users receive our 
quarterly newsletter, MicroSim 
Source, which provides 
valuable reference information. 
Overview
The MicroSim family of products is fully integrated, giving you
the flexibility to work through your circuit design in a consisten
environment.

This guide describes installation and configuration procedur
for Microsoft Windows 3.1 (or later), NT and 95. 

After reading the general information in this chapter, follow th
specific installation instructions discussed in Chapter 2.

The readme.wri File
Provided with your software is a readme.wri  file that you 
should print and read carefully before beginning the installati
process. This file contains last minute information that did n
get included into this edition of the documentation.

The readme.wri  file is located on Disk 1 of the diskettes an
in the root directory of the CD-ROM.

Product Registration
You have an opportunity to fill out the registration card at the
end of the installation process. If you elect not to do so, the 
regcard.wri  is available for you to fill out (double-click on
the icon in the MicroSim program group) at anytime.

 Please take a moment to complete the document, print it, a
return it to MicroSim Corporation. This document allows us t
keep you informed of new program announcements and prod
updates. 
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Note Circuit entry methods are 
executed through MicroSim 
Schematics.

Note Hard copy manuals can 
be purchased; contact the 
MicroSim sales office at (800) 
245-3022.
MicroSim 
Documentation
Since MicroSim software is available in multiple 
configurations, we have coordinated the manuals in much th
same manner. 

The documentation is available in hard-copy and on-line. Th
type of documentation you receive depends on the configura
you have purchased. On-line documentation is distributed to
users who install MicroSim products by CD-ROM. Refer to 
your user’s guide for more information on the available hard
copy documentation. 

On-Line Manuals
As mentioned before, users that install MicroSim products v
CD-ROM will receive on-line manuals. 

On-line manuals are provided in Adobe’s Portable Documen
Format (.pdf). They can be displayed and printed exactly as
original from any computer on most platforms (Windows 3.1 
later, NT and 95), regardless of the fonts or software progra
on the computer.

The Acrobat Reader application for reading, navigating and 
printing PDF documents, is available on the MicroSim CD-
ROM. Along with the Adobe Reader is an Acrobat Search 
application that allows you to load indexes of one or more 
manuals so you can search across them. 

Please refer to any one of the Adobe on-line manuals that w
installed with your MicroSim on-line manuals for more 
information on how to:

• use the Adobe Reader

• load indexes

• use the search tool
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For diskette customers:

• a set of diskettes in 3.5” 
format that contains the 
programs, library files and 
example circuit and 
schematic files

• a set of Microsoft Win32 OLE 
installation diskettes

• a parallel security plug

• a set of hard-copy manuals

Note If you purchased 
MicroSim Schematics only you 
do not need a parallel security 
plug to operate the software.

New users may also order the 
book SPICE, A Guide to 
Circuit Simulation and 
Analysis Using PSpice, 
second edition (Prentice-Hall, 
1992). 
Before You Begin 
Installation
Before you begin the installation process you should check 
shipping contents to make sure you have received all items 
your operating system. The shipping contents for CD-ROM 
customers include:

• a CD-ROM that contains the following:

• the MicroSim programs, library files and example 
circuit and schematic files

•  Microsoft Win32 OLE files

• on-line manuals

• a parallel security plug 

• a set of hard-copy manuals

If you purchased a system that includes circuit simulation an
Probe waveform analysis, you should have the following 
documentation:

• PSpice A/D & Basics+ User’s Guide or PSpice & Basics 
User’s Guide

• PSpice A/D Reference Manual

• MicroSim Application Notes

If your system includes MicroSim Schematics, you should 
receive the following documentation:

• MicroSim Schematics User’s Guide 

If you discover that an item is damaged or missing, contact 
MicroSim Product Marketing:

(714) 770-3022 or (800) 245-3022
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What’s New in this Release?
If you are already familiar with a previous version of MicroSim
software, you should read the What’s New in This Release 
section of your user’s guide and take note of the new feature
and product enhancements.
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Technical Support
If you encounter a problem during installation or use of any 
MicroSim’s products, contact Technical Support.

Application Engineers are available from 8:30 am to 5:00 pm
Pacific Standard Time, Monday through Friday. 

When calling, make sure you have the following information
readily available:

• your program ID number

• the program(s) you are using (PSpice, Parts, etc.)

• the type of computer and operating system you are usin
(including the release version)

• amount of memory installed in the system

The following table outlines the contact phone numbers and
mail addresses for MicroSim.

 

About the MicroSim BBS
On the BBS you will find information regarding operation and
message utility that allows you to provide your comments an
suggestions. The BBS can be reached by dialing:

(714) 830-1550  (1200-14.4K baud, N-8-1)

The BBS supports several terminal types, including ANSI an
VT100/VT102.

Contact Address/Number

Technical Support E-Mail Tech.Support@MicroSim.com

Technical Support Phone (714) 837-0790

24-hour Fax (714) 455-0554

24-hour AutoFax (714) 454-3296

24-hour BBS (714) 830-1550
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About MicroSim AutoFax
MicroSim AutoFax is a simple-to-operate automated fax 
response system. It is available 24-hours a day, 7 days a we
(voice prompts are in English only).

With AutoFax you can:

• request a catalog of available Sales and/or Technical 
documents

• order documents

• listen to Quick Pick items

• access MicroSim product information, technical notes, a
answers to some FAQs (Frequently Asked Questions)

About MicroSim’s World Wide 
Web Site
Our WWW address is:

 http://www.microsim.com. 

Read about MicroSim product, service, and support offering
View our quarterly customer newsletters (MicroSim Source,
July and October 1995). Access our anonymous FTP site to 
download free evaluation software.



Installing MicroSim 
Applications
1

Overview
This chapter provides detailed instructions for installing 
MicroSim applications in the Windows environment. The 
following topics are covered:

• system requirements

• installing the security plug

• installing MicroSoft Win32 OLE files

• installing MicroSim applications
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Note At least 4 megabytes of 
extended memory (not 
expanded or LIM) for a MicroSim 
Schematics installation only.

Note A parallel port is not 
required if you are only installing 
Schematics.
System Requirements
The following sections outline the minimum hardware and 
software requirements for installing MicroSim applications o
Windows 3.1 (or later), 95 and NT.

Required Hardware
• an IBM 80386, 80486, or Pentium-based PC (or 

compatible) computer with the following features:

• 640 kilobytes of DOS (low) memory

• at least 8 megabytes of extended memory (not expan
or LIM) or more is recommended for configurations 
with PSpice A/D (or PSpice) and MicroSim 
Schematics.

• 80x87 floating-point coprocessor (compatible with th
system)

• VGA, EGA, or most other displays (color and 
monochrome) supported by Windows

• a parallel port (or a serial port if you are installing an 
upgrade to the single-user version)

• at least one high-density floppy drive or a CD-ROM drive

• a mouse
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Note Microsoft Win32 OLE files 
are provided with the MicroSim 
diskettes and on the CD-ROM.

Testing the Security Plug

The security plug is transparent 
to other users of the port, such 
as, a printer. To verify there are 
no conflicts with the port, perform
the following test:

1 Unplug the printer connector 
and install the security plug 
into the appropriate port 
(serial for non-network 
updates, parallel for new 
installations). 

2 Plug the printer connector 
into the other end of the 
security device.

3 Run a print job to verify that 
your printer is operating 
properly.

The security plug should not 
interfere with data sent in either 
direction on the port. The 
interrogation of the security plug
by the MicroSim software does 
not effect printer operation.
Required Software
One of the following operating systems:

• Windows 3.1 (or later), installed and running in 386 
enhanced mode, with:

• MS-DOS 3.0 (or later; 5.0 recommended)

• Microsoft Win32 OLE files (V1.30 or later)

• Windows 95

• hinstall.exe (V2.01)

• Windows NT (V3.51)

• hinstall.exe (V2.01)

Installing the Security 
Plug
Before installing MicroSim applications, you must install the
security plug. 

Install the security plug into a parallel port on the back of yo
computer.

Note If you connect the security plug into the wrong type of 
port or backwards, you will not damage the security 
plug, however, the applications will not run. 

connect this
side into the 
computer
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SECURITYPORT in the msim.ini 
file is only for serial plugs. All 
parallel ports will be scanned; 
there is no way to specify which 
port the plug is in.

Additionally, if you are installing 
different simulator configurations 
(such as a combination of 
analog-only, digital-only, and 
mixed (A/D) simulators) then 
each package must be installed 
in a separate directory.
Non-Network

Serial plug

If you currently have a serial security plug, and you are updating 
a non-network version, you can continue to use the same 
security plug, as long as you continue to run under Windows 
(or later). 

Note If you want to run under Windows NT or 95, contact the 
MicroSim Sales Department for information on how to 
trade your serial plug for a parallel plug.

Parallel plug

If you are installing a new, non-network version of the software
install the security plug on a parallel port. Parallel plugs run 
under Windows 3.1 (or later), NT and 95.

Network Installations

Single-network 

If you are installing a network version of the software, install t
security plug on a parallel port. See Installing on PC-Based 
Networks.

Multiple-network

If you are installing more than one network version, each 
security plug must be installed on a different license server.
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If the Win32 OLE files currently 
installed on your system are a 
more current version than what 
is provided with MicroSim 
software, you will be notified. If 
this occurs, keep the installed 
version and continue on with the 
installation. 

If the Win32 OLE files provided 
with MicroSim software are a 
more current version, then the 
files will be updated 

t ti ll
Installing MicroSim 
Applications

Before You Begin
During the installation be ready to answer the following 
prompts:

• The drive and directory of where you want the applicatio
to be installed.

• Whether you want to do a complete or partial installation

• Whether you want to have the installer perform various 
system configuration options, such as creating a program
group and icons.

Throughout the installation process, the installer displays th
progress of the installation. If you want to abort the installatio
press E. Note that doing this will result in an incomplete 
installation. 

Note Should you abort the installation process, be sure to 
delete the installed files from your system before 
beginning the installation again.

Installing Win32 OLE Files for 
Windows 3.X
Note You must install the Win32 OLE files (V1.30a or later) 

before you install MicroSim applications.

If you have already installed Microsoft Win32 OLE files in 
conjunction with another program, you should still proceed with 
the following steps. 
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Note Backing up this file is a 
precautionary measure that you 
should take in case the Win32 
OLE installation is not 
successful.

Note Backing up this file is a 
precautionary measure that you 
should take in case the Win32 
OLE installation is not 
successful.

Note If you are updating the 
Win32 OLE files, you may not be 
prompted for disk #2. 
From CD-ROM

 To install the Win32 OLE files, do the following:

1 Make a backup copy of your \windows\win.ini file 
under another file name.

2 Insert the CD into your CD drive.

3 Select the following directory on the CD through the File
Manager:

\ole325\130\disk1

4 Double-click on the file setup.exe .

5 Follow the instructions on the screen to complete the 
installation.

From Diskettes

 To install the Win32 OLE files, do the following:

1 Make a backup copy of your \windows\win.ini file 
under another file name. 

Note

2 Insert Microsoft Win32 OLE installation disk #1 into your
floppy drive.

3 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar.

b Select Run.

4 In the Run dialog box type in the command line:

 <drive >:\setup.exe

where drive is your local floppy drive. 

5 Press Ror click OK.

6 Insert the Microsoft Win32 OLE installation disk #2 when
prompted. 

7 Follow the instructions on the screen to complete the 
installation.
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If you are installing on computer 
running Windows NT, you need 
to be ADMINISTRATOR to 
install/uninstall hinstall.
Installing hinstall.exe for 
Windows NT and 95
If you have an older version of hinstall.exe  installed (prior 
to V2.01) you need to:

1 Uninstall hinstall.exe  (hinstall -r).

2 Reboot.

3 Re-install hinstall.exe V2.01 (hinstall -i).

4 Type hinstall /info  to see if the drivers were 
successfully installed. 

From CD-ROM

 To install hinstall.exe , do the following:

1 Insert the CD into your CD drive.

2 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar.

b Select Run.

3 In the Run dialog box type in the command line:

 <drive>:\hinstall.exe -i

where drive is your CD-ROM drive. 

4 Press Ror click OK.

From Diskettes

 To install hinstall.exe , do the following:

1 Insert MicroSim installation disk #1 into your floppy drive

2 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar.

b Select Run.

3 In the Run dialog box type in the command line:
 <drive >:\hinstall.exe -i

where drive is your local floppy drive. 

4 Press Ror click OK.
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Installing the Applications from 
CD-ROM
To install MicroSim applications, you need to run the 
installation program from within Microsoft Windows.

1 Start Windows.

2 Insert the CD into your CD drive.

3 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar.

b Select Run.

4 In the Run dialog box type in the command line:

 <drive>:\setup

where drive is your CD-ROM drive. 

5 Press Ror click OK.

6 Dialog boxes from the installation window will prompt you
for information and instruct you on how to proceed throug
the installation. 

Successful installation means all of your applications and th
accompanying symbol and model library files will be installe
With your approval, a Windows Program Group called 
MicroSim  will be created containing icons for each program
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If you have Filter Designer, 
Device Equations, PLSyn, 
PSpice Optimizer, or MicroSim 
PCBoards you will receive 
separate installation diskettes. 

The procedure for installing 
these applications is identical to 
the procedure outlined, except 
you must insert the specific 
program disk (step 2) instead of 
the application setup disk. 
Installing the Applications from 
Diskette
To install MicroSim applications, you need to run the 
installation program from within Microsoft Windows.

1 Start Windows.

2 Insert the MicroSim application setup disk labeled disk 1
into your floppy drive.

3 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar

b Select Run.

4 In the Run dialog box type in the command line:

 <drive>:\setup

where drive is your local floppy drive. 

5 Press Ror click OK.

The installation window appears; dialog boxes from this 
window will prompt you for information and instruct you on 
how to proceed through the installation. 

Successful installation means all of your applications and th
accompanying symbol and model library files will be installe
With your approval, a Windows Program Group called 
MicroSim  will be created containing icons for each program
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Note This information applies 
to Windows 3.X only.

Note This information applies 
to Windows 3.X only.
Installing Schematics Only
A Schematics installation only, does not require a security plug
or an authorization code, however, it does require a program
number.

To install Schematics only, when prompted:

1 Enter the ID number.

2 Select the radio button: Schematics and/or symbol librar
only.

You will not be prompted for an authorization code.

The program ID number is recorded in the msim.ini file in th
[MicroSim] section as MSIMID. This information then become
available in the About box when you need to reference it for
Technical Support. Your program ID number is always requir
when contacting MicroSim technical support.

Installing All Other MicroSim 
Applications 
All other installations require a program ID number, a securi
plug, and an authorization code.

For installations in which you want to install more than just 
Schematics, when prompted:

1 Enter the ID number.

2 Select the radio button: Other.

3 Enter your authorization code.

The installation will include Schematics as well as the other 
products you have purchased/licensed.
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Note This information applies 
to Windows 3.X only.

Customized msim.ini files:

If you have customized some of 
the settings in the msim.ini  file 
(such as, color selection or 
printer information), you may 
want to make a back-up copy of 
the old file to ensure your 
settings do not get overwritten. 
After installation, you can refer to 
the backup copy when editing 
the new version of the 
msim.ini.

Circuit, schematic, data, and 
output files from earlier versions 
are compatible with this release, 
and do not require any special 
processing. However, some files 
created with this release may not 
be compatible with earlier 
releases.
Installing and Selecting Libraries
Depending on the MicroSim applications you have purchase
you have several options when installing libraries:

• Analog simulation models with symbols— for those who
have PSpice or PSpice A/D and plan to simulate using t
analog devices provided by MicroSim.

• Digital simulation models with symbols—for those who 
have PSpice A/D or PLogic with PLSyn and plan to 
simulate using the digital device models provided by 
MicroSim.

• Component symbols (no models)—for those who have 
Schematics or MicroSim PCBoards and plan to use the 
schematic symbols.

Note If you are installing Schematics only and you select one 
of the options that contain models; no model libraries 
will be installed, you will only get the symbols for the 
devices contained in those libraries. Model library 
installations require a PSpice or PSpice A/D license and 
authorization code.

Installing Over a 
Previous Version
Note If you already have a previous version of MicroSim 

applications installed on your system, read the following 
section very carefully. 

Each time you run the MicroSim installation program, it 
automatically makes a backup copy of your msim.ini  (named 
msim.bak ) and creates a new version.
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Troubleshooting Your 
Installation
There are three components to every MicroSim product:

• program ID number—a 5-digit serial number

• security plug—either a parallel port (white) plug, or a seri
port (black) plug

• authorization code—an alphanumeric string of 28 numbe
and characters (the code is not case-sensitive so it does
matter whether you type the letters in upper or lower cas

Invalid authorization code or user ID

If you get this message, do the following:

1 Verify that the security plug is correctly installed on the 
appropriate port. See Installing the Security Plug on 
page 1-3.

2 Verify that you have entered the authorization code 
correctly. 

3 For Windows NT and 95, verify that hinstall  has been 
installed by typing: hinstall /info .

This program is incompatible with other files in 
the release area

If you get this message, do the following:

1 Run the installation program again.

2 Select “Regenerate License File” on the initial screen.

3 Verify that you are using the correct authorization code 
assigned for this release.



Configuring the Printer and Monitor 1-13

 

l 
 
ns 

o 

he 

the 

e 
c.
Configuring the Printer 
and Monitor
All MicroSim applications, as Windows applications, will use
the default Windows printer and monitor configurations. 
Therefore, no special procedures are required for monitor 
selection and printer installation. 

If you have already installed your printer through the Contro
Panel, you should designate it as your default printer. If you
have not already installed your printer, refer to the instructio
provided by your printer manufacturer and your Microsoft 
Windows documentation.

Configuring the Printer from 
within MicroSim Applications
For convenience, MicroSim applications provide the option t
configure a printer from within each program. 

To configure your printer, do the following:

1 Select the Printer Select menu.

2 Select a printer from the list of installed printers, or keep t
currently selected default.

3 Once you have selected a printer, click Setup to display 
Printer Setup menu for configuration. 

This dialog box allows you to change such options as th
print orientation (portrait or landscape), paper source, et



1-14 Installing MicroSim Applications

 

e 
 

art 

 

d 

re 

s:

 

The msim.ini  file is updated 
when you make configuration 
changes from within Schematics. 
This file can also be modified 
using a standard text editor 
(such as Notepad). 
Customization Options
The command line options listed in the PSpice A/D Reference 
Manual are not required, however, they can be added to any
application command line.

From the icon

The following procedure outlines how to add a command lin
option when you are running MicroSim applications from the
icon—not from within Schematics. 

1 Install the application as described on page 1-5.

2 Find the program icon in the MicroSim program group.

3 Click once on the respective icon to select it, but do not st
the program.

4 Select the File pull-down menu from the menu bar.

5 Select Properties from the File menu.

6 Edit the Command field to include the desired command
line options.

The file msim.ini  contains default configuration settings an
some general software configuration settings. This file was 
created during installation, and is located in the directory whe
Windows is installed (usually c:\windows).

From within Schematics 

The following procedure outlines how to add command line 
options when you are running MicroSim applications from 
within Schematics.

To change the command line options from within Schematic

1  Select Editor Configuration from the Options menu.

2 Click the App Settings button in the Editor Configuration
dialog box.

3 Change command line options as necessary.
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This chapter describes the procedure for installing MicroSim
applications on PC-based networks. This chapter includes t
following sections:

Stand-Alone versus Network Licenses on page 2-2

Security Plugs on page 2-3

Network Installations on page 2-4

Selecting a License Server on page 2-7

Installing a Network License on page 2-8

Network Classes on page 2-12

IPX Networks on page 2-12

Local Networks and Internetworks under Novell on page 2-1
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Note Refer to the readme.wri 
file for more information on 
running network versions under 
Windows NT and 95.
Stand-Alone versus 
Network Licenses

Stand-alone licenses 

allow a single user to use MicroSim applications on one 
computer at a time with a security plug attached directly to t
computer. The applications can be copied to multiple 
computers, however, only the computer with the security plug 
will be able to run the applications.

Network licenses 

allow multiple users to use MicroSim applications running in
network configuration with the security plug attached to a 
license server. 

Note The license server can be any computer on the network, 
such as a Novell Netware file server or a client 
workstation. This license server monitors the number of 
users.

With both stand-alone and network versions, you can install 
applications on a local drive, or on a network drive and then
copy the necessary files to individual computers as needed.
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If you have multiple security 
plugs, each plug must be 
installed on a different license 
server. See Setting Up Multiple 
License Servers on page 2-7.
Security Plugs
If you are updating to a network version of the applications fro
a non-network version, you should have received a new secu
plug with your new applications.   See Installing the Security 
Plug on page 1-3.

Updating the Security Plug
If you are updating from a previous network version, you ca
continue to use the same security plug. However, you must r 
nlupdate.exe, which is located on the Network Security
Plug update disk.

1 Install the security plug. See Installing the Security Plug on 
page 1-3.

2 Insert the Network Security Plug update disk into your 
floppy drive.

3 Select the Program Manager and do the following:

a Select the File pull-down menu from the menu bar

b Select Run.

4 In the Run dialog box type in the command line:

 <drive >:\nlupdate.exe

where drive is your local floppy drive. 

5 Press Ror click OK.

Using the Security Plug with 
other Security Devices
The security plug may be connected in series with other secu
devices. If you have multiple security plugs from MicroSim, 
they must be loaded on different license servers.
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Network Installations
Network licensing allows you to run one or more copies of th
programs (e.g., PSpice, Probe, or Parts) on any node on the
network without being locked to a specific node. This is 
accomplished by designating one computer as a license ser
to handle requests for individual licenses from elsewhere on
network. 

The license server requires a security plug. The license serv
may be any computer on the network, such as a Novell Netw
file server or a client workstation. The security plug attaches
the parallel port on the license server; the plug does not affe
the operation of printers or other devices. 

Once the license server is set up, each license is checked in and 
checked out from the license server by a utility running on the
license server that administers the licenses throughout the 
network. This process is completely transparent.

See Selecting a License Server on page 2-7, for more 
information on license servers.

Note For a complete list of supported protocols, please see 
the readme.wri file.

The computers connected to the network that run the MicroS
applications do not need any additional software. 

Note The license server must remain running while MicroSim 
applications are in use.
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You can also configure 
computers individually through 
the installation program option 
“Configure Network Node.”
Setting Up Individual Computers
If you install the applications on a network drive, each compu
connected to the network drive should have a copy of the 
msim.ini file on its local drive.

Which means, each computer that runs MicroSim applicatio
should have a copy of the msim.ini  file located in the 
\windows  directory.

To setup individual computers:

1 Edit themsim.ini file to specify a local backup directory
by changing the setting of the BACKUP entry (in the 
[MicroSim] section) to the name of a directory on the loc
drive. 

2 Create a new program group and add the appropriate 
MicroSim icons.
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Note Changing the command 
line ensures that the temporary 
files written by the simulator do 
not conflict with the files from 
other users working from the 
same drive.
Installing Data Files: Local 
versus Network
Program executables and data files can be installed either loc
(on individual local drives) or on a network drive. 

Note For best performance, install the executables and data 
files locally.

If you are using MicroSim applications to simulate circuits th
are located on a network (shared) drive, do the following.

Running PSpice (A/D) from the icon

1 Create a TEMP directory on a local drive, if one does no
already exist.

2 In the Program Manager select Properties from the File 
menu.

3 Modify the simulator command line to include the 
following option:

-wTEMP=<local temp drive and directory >

where <local temp drive and directory> indicates the 
location of the TEMP directory. 

Running PSpice (A/D) from Schematics

1 Create a TEMP directory on a local drive, if one does no
already exist.

2 From Schematics:

a Select Editor Configuration from the Options menu.

b Click the App Settings button in the Editor 
Configuration dialog box.

3 Modify the simulator command line to include the 
following option:

-wTEMP=<local temp drive and directory >

where <local temp drive and directory> indicates the 
location of the TEMP directory. 
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Selecting a License 
Server
The computer you choose to be the license server will depen
your network configuration. However, whatever the 
configuration, the computer must have a parallel port. The m
requirement for the license server is that the computer must
stable, which means it should not be subject to frequent re-
booting. Additionally, the license service must be isolated fro
interruptions. 

Setting Up Multiple License 
Servers
If you have more than one license server running NETBIOS
NETBEUI, do the following:

1 In the autoexec.bat  file on each client workstation (i.e.,
any machine that will be running MicroSim applications)
add the following line:

SET HASPNBNAME=<name>

where name is an arbitrary name up to eight characters, a
is case sensitive.

Setting this environment variable at a station will force a sea
for a NetHASP server, which was loaded with the switch -
NBNAME=<name>.

2 Start nhsrvwin on the license server with the following
option:

nhsrvwin -NBNAME=<name>

Using the -NBNAME switch will only allow computers with a 
matching HASPNBNAME environment variable to obtain a 
license.

Note If you have more than one license server running IPX, 
there are no special requirements.



2-8 Installing on PC-Based Networks

, 
 the 
ion 

s 

te 
Installing a Network 
License 
After you have selected a computer to be the license server
connect the security plug to the parallel port; then, proceed to
section that applies to your to license administration applicat
needs.

Setting Up a Novell Netware 386 
File Server
The license administration application, haspserv.nlm , is in 
the form of an NLM (network loadable module). To install thi
application, do the following:

1 Copy haspserv.nlm  from:

a the MicroSim Network Files disk, or

b the \network  directory on the CD-ROM

to the SYS:SYSTEM directory.   

2 Type at the fileserver’s console prompt:

load CLIB

load haspserv.nlm

Note Add these commands to the autoexec.ncf  file, which 
resides in the SYS:SYSTEM directory, to make sure the 
license server is activated when the file server boots up.

The server application uses the SAP protocol to communica
between the license server and the applications.

Note If you are using Novell Netware on a 386 file server, you 
must have V3.0 of the Novell software (or later).
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Setting Up a Novell Netware 286 
File Server
The license administration application, haspserv.vap,  is in 
the form of a VAP (value added process). To install this 
application, do the following:

1 Copy haspserv.vap  from:

a the MicroSim Network Files disk, or

b the \network  directory on the CD-ROM

to the SYS:SYSTEM directory.   

2 Re-boot the file server.

When the server is loaded, a message displays prompting f
confirmation on whether haspserv should be installed. 

3 Click on Yes.  

4 To avoid this message, add the following line to the 
server.cfg  file in the SYS:SYSTEM directory:   

VAP WAIT = 10

The server application uses the SAP protocol to communica
between the license server and the applications.
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Setting Up Novell Netware Lite
The license administration application, haspserv.exe,  is in 
the form of a TSR (terminate-stay resident) program. To inst
this application, do the following:

1 Copy haspserv.exe  from:

a the MicroSim Network Files disk, or

b the \network  directory on the CD-ROM

to a public directory in the network’s search map.   

2 Start the program only by the license server, after the 
network application has been loaded. 

When it runs, HASPSERV creates a file called 
newhaddr.dat , which is used by the program to find the
license server. 

Note Note that if you move the haspserv  files to another 
directory or change which computer is the license 
server, you must delete the old newhaddr.dat  file. 

3 For each computer running the program (clients and 
servers), add the following line to the autoexec.bat  
file:

append < drive :>

where <drive:> maps to the location of newhaddr.dat  
located on the license server. 

4  For the server, add the following:

append c:\msim63

5 For the client, add the following:

append f:
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Note For a complete list of 
supported protocols, please see 
the readme.wri file.

This program can be placed in 
your start-up group.

Note The environment variable 
values must be in UPPERCASE 
letters. Note that you will need to 
set the environment variable in 
DOS before you start Windows.
Setting Up Other PCs
Other computers may be used as the license server if they h
IPX or NETBIOS loaded.

The license administration application, nhsrvwin.exe , is in 
the form of a TSR (terminate-stay resident) program. To inst
this application, do the following:

1 Copy nhsrvwin.exe  from:

a the MicroSim Network Files disk, or

b the \network  directory on the CD-ROM

to the desired directory on the license server.

2 Run it from the Program Manager by doing the following

a Select the File pull-down menu from the menu bar

b Select Run.

3 In the Run dialog box type in the command line:

 <path>\nhsrvwin.exe

4 Press Ror click OK.

5 When nhsrvwin  is started, it automatically recognizes 
the network type and selects the appropriate protocol. Y
can override the protocol when starting nhsrvwin  by 
using one of the following command line options:

-NETBIOS

-IPX

-IPXNOSAP 

6 If you override the protocol used by the server, you also
need to override the protocol used on each client 
workstation. To do this, create an environment variable 
named NETHASPPROTOCOL and set it to one of the thr
values:

SET NETHASPPROTOCOL=NETBIOS

SET NETHASPPROTOCOL=IPX

SET NETHASPPROTOCOL=IPXNOSAP
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Note For a complete list of 
supported protocols, please see 
the readme.wri file.

Pathworks is an example of a 
network that has both IPX and 
NETBIOS. It does not run either 
IPX or NEBOIS, but client 
workstations may run a 
NETBIOS layer over Pathworks’ 
native protocol (NETBIOS must 
be set up as the primary protocol 
in this case). 

Communication is actually 
performed with Pathworks’ 
native protocol but the NETBIOS 
layer allows the NetHASP 
application to interface with 
Pathworks with the normal 
NETBIOS API.
Network Classes
There are three classes of networks that NetHASP supports
Table 2-1 lists the classes and some specific examples.

All stations accessing the NetHASP license server must sha
common network protocol. The NetHASP system currently 
supports two protocols: 

• IPX

• NETBIOS/NETBEUI

If your network has both, ensure that both the clients and se
are running the same protocol. Other network protocols are 
supported if they can run a NETBIOS layer on top of their 
standard protocol. 

IPX Networks
On a Novell IPX-based network there are five possible 
situations of license server application vs. workstation/serve
these are summarized in Table 2-2.

Table 2-1 Classes of Networks Based on Protocol

IPX Networks
NETBIOS/NETBEUI 
Networks

Other 
Network 
Protocols

Novell Netware 2.x Lantastic Pathworks

Novell Netware 3.x LAN Manager Banyan Vines

Novell Netware 4.x 
in Bindery Emulation

PC/NFS
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Local Networks and 
Internetworks under 
Novell

A local network 

is a single cabling scheme identified by a unique network 
number, to which one or more stations are connected.

An internetwork 

is a group of two or more local networks linked together.

When you load the NetHASP Server program, it advertises 
name to the entire internetwork (by default) and serves all of 
internetwork’s local networks and stations (by default). If the
default suits your needs, that is, you want the NetHASP Ser
program to sever the entire network, you can skip the followi
sections.

If the defaults do not suit your needs, you can instruct the 
NetHASP Server program to serve only a specific local netwo
The following sections describe how to load the various 
NetHASP Server programs to serve a local network only.

Table 2-2 Netware License Servers

Computer License Server

Netware 2.x server HASPSERV.VAP

Netware 3.x server HASPSERV.NLM

Netware 4.x server 
(in Bindery Emulation)

HASPSERV.NLM

DOS Workstation HASPSERV.EXE

Windows 3.x Workstation NHSRVWIN.EXE
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Specifying Local Networks with 
HASPSERV.NLM
To instruct HASPSERV.NLM to serve only those local 
networks connected to the file server on which 
HASPSERV.NLM is running, load it with the LOCALNET 
switch:

load haspserv localnet

To instruct a station to communicate only with the 
HASPSERV.NLM that serves the station’s local network (an
not with other servers loaded on the internetwork) set the 
following environment variable:

SET NETHASPPROTOCOL=LOCALNET

To instruct HASPSERV to advertise its address with a spec
local network number, load it with the NET switch:

load haspserv net m [net n...]

where m and n are IPX network numbers in the internetwork. T
find out the network numbers of a NetHASP Server, enter 
config  in the file server console. The information displayed
on the screen contains the network numbers.

Note Note that although HASPSERV.NLM advertises its 
address with specific network numbers, it continues to 
serve all of the stations in the entire internetwork. 
HASPSERV serves the specified local networks only 
when it is loaded with the LOCALNET switch and with 
the NET switch, concurrently.
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Example

An internetwork consists of local networks A, B, C, etc. 
HASPSERV.NLM is running on a file server to which local 
networks A and B are connected directly. You want MicroSi
applications to run only on computers belonging to local 
network A. Initially, HASPSERV.NLM was loaded as follows

load haspserv

Loaded this way, HASPSERV.NLM serves all the local 
networks in the entire internetwork. This allows computers 
(from local networks other than local network A) to access th
NetHASP key, and therefore, run MicroSim applications tha
aren’t assigned to them. Additionally, computers from local 
network A search for the NetHASP key throughout the entire
internetwork.

To solve this problem:

1 Load HASPSERV.NLM as follows:

load haspserv net A localnet

The LOCALNET switch prevents HASPSERV.NLM from
serving all the computers in the entire internetwork. 
Moreover, the NET switch ensures that HASPSERV.NLM
now serves only local network A.

2 To ensure the computers in local network A communica
with the above HASPSERV.NLM, and not with others in
the internetwork, set the following environment variable 
each computer:

set NETHASPPROTOCOL=LOCALNET
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Specifying Local Networks with 
other Servers
To instruct HASPSERV.EXE or NHSRVWIN.EXE to serve a
local network, use one of the following switches when loading 
it:

haspserv -localnet

nhsrvwin -localnet

Note  If you load the NetHASP Server program without using 
the LOCALNET switch, it serves all of the networks and 
computers in the entire internetwork. 

You can instruct a computer to access only the NetHASP Ser
program (that advertised its name with the computer’s local 
network). To do this, set the computer’s environment variab
NETHASPPRTOCOL as follows:

SET NETHASPPROTOCOL=LOCALNET

Troubleshooting
Note Refer to the readme.wri file for the latest network 

troubleshooting techniques.

Table 2-3 Network Troubleshooting Techniques

Message Page

Network Not Responding 2-17

Error Messages 2-18

Stand-alone, Non-network PC 2-20

Setting Time-out Length 2-20

Program Crashes 2-21

License Server Crashes 2-21
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Network Not Responding

Table 2-4 Network Not Responding Troubleshooting

Instruction Action/Solution

Is the security plug installed 
on a Novell fileserver, or 
some other PC on the 
network?

The plug can be installed on either the 
fileserver or a PC.

Is the PC with the plug 
running Windows 3.1 or 3.11, 
with haspserv.exe  or 
nhsrvwin.exe ?

• Windows 3.11 requires 
nhsrvwin.exe .

• If you are running Windows 3.1 and 
haspserv.exe , try 
nhsrvwin.exe  instead.

Which protocol are you 
using?

• We support IPX and/or NETBIOS/
NETBEUI.

• You may run multiple protocols as 
long as one of the protocols is either 
IPX or NETBIOS/NETBEUI.

• In the case of multiple protocols, e.g., 
TCP/IP and NETBIOS, NETBIOS 
must be primary.

Which version of 
haspserv.exe  or 
nhsrvwin.exe  are you 
running?

Use the version provided on the 
MicroSim Network Files disk or in the 
\network directory on the CD-ROM.

Are you using any options 
(e.g., -NETBIOS) on the 
nhsrvwin.exe line?

The -localnet option only works with 
IPX and not with NETBIOS/NETBEUI.

If you are having problems and have a 
NETBIOS/NETBEUI network, try 
adding (all caps):

SET NETHASPPROTOCOL=NETBIOS

to the autoexec.bat  file of the client 
workstation, rebooting, and then starting 
nhsrvwin.exe with the -NETBIOS 
option, i.e.,

nhsrvwin -NETBIOS
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Error Messages

Table 2-5 Error Messages Troubleshooting

Message Description/Solution

communication or 
protocol problems

Usually means NETBIOS/NETBEUI is not the 
primary protocol.

If you are using Windows 3.11

1 Select Network/Network Setup/Drivers.

2 Make sure NETBEUI or NETBIOS is 
selected as primary.

If IPX/SPX Compatible Transport is anywhere in 
the list of protocols delete it if you don’t need it. 
If you don’t want to delete IPX/SPX Compatible 
Transport:

1 Select Network/Network Setup/Drivers.

2 Click on IPX/SPX Compatible Setup 
Transport/Setup. 

3 In the Advanced Protocol Settings dialog 
box, click on the Frame Type/Value.

4 Select the correct Frame Type (whatever 
your network is defaulting to).

communication or 
protocol problems 
on some computers, 
but not on others

If this message appears on some computers, but
not on others:

1 Check the items in the procedures listed 
above. 

2 If the computers that aren’t working are on a 
different subnet than the computers that are 
working, the routers MUST be able to route 
NETBIOS.

3 If you do not want to pass NETBIOS through 
the routers, you MUST get a different 
network license for every subnet running 
MicroSim applications.
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security plug is not 
connected to server

See Setting Up Multiple License Servers 
on page 2-7.

cannot find a license 
server

1 Make sure you are running 
haspserv.exe  or nhsrvwin.exe .

2 If you are running Windows 3.1 or 3.11, and 
are running haspserv.exe  try 
nhsrvwin.exe  instead.

3 If some MicroSim applications work and 
others do not, and you updated from an 
earlier version, run nlupdate  to update the 
plug. See Updating the Security Plug 
on page 2-3.

4 Try the procedures listed in “Communication 
or protocol problems.”

license lost If you are experiencing this message frequently, 
and are running the IPX protocol, see Local 
Networks and Internetworks under 
Novell on page 2-13.

Table 2-5 Error Messages Troubleshooting
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Stand-alone, Non-network PC
1 The PC must have a network card.

2 The IPX protocol must be loaded. 

Note You cannot run on a stand-alone PC using the 
NETBIOS protocol.

3 In DOS, before launching Windows, type (all caps)

SET NETHASPPROTOCOL=IPXNOSAP

4 Move haspserv.exe  or nhsrvwin.exe  to the 
MicroSim installation directory, e.g., c:\msim63.

5 Start haspserv.exe  or nhsrvwin.exe  with the
- ipxnosap option, i.e.,

nhsrvwin -IPXNOSAP

Once the network license application has been installed on 
license server, the application should operate smoothly. 

Setting Time-Out Length
If you receive the following message:

Server is busy - check time-out lengths

There are two environment variables to set time-outs for the
transactions between the PC and the license server.   

SET NETHASPSESSION=nn Determines the maximum length 
of time (in seconds) for which the 
program will continue trying to 
establish a connection.

SET NETHASPSENDRCV=mm Determines the maximum length 
of time (in seconds) for each send 
and receive packet.
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Program Crashes
When the computer running the application crashes, the lice
may remain checked out from the server. To correct this, you 
have three options:

1 If no one else is using the program, you can re-boot the 
license server. 

Note Note that if anyone is using the server, their sessions 
could be interrupted.

2 After the computer has re-booted, re-run and then exit th
program that was running at the time of the crash. This w
make the license available for use by others.

3 The license will automatically check itself back in after 2
hours.

License Server Crashes
If the license server becomes unavailable for any reason wh
the application is running, you may be prompted to remedy t
situation before you will be allowed to resume operation. Eve
attempt is made by the application to provide uninterrupted 
service.
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Overview
The configuration file msim.ini  is an ASCII text file that 
contains the initialization settings, which control how MicroSim
applications programs are started, their color and initializatio
settings.
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Introduction
The msim.ini  file is created when you perform the 
installation process. 

In Windows, it is located in the directory where Windows is 
installed (usually c:\windows). The file is divided into section
and each section has a title name enclosed in brackets. 

For example, the first section is [MICROSIM]. Each section 
contains settings which follow the format:

<keyword>=<value>

where the <keyword> is the name of the setting and <value> 
defines the value of the setting. 

For example:

LIBPATH=c:\msim\lib

indicates that the LIBPATH setting will point to the directory
c:\msim\lib. 
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To change items that are 
configurable through the text 
editor, it is important to note that:

• the <keyword> is followed by 
an equal sign (=) with no 
spaces in between

• the <value> can be an 
integer, a string, or a quoted 
string, depending on the 
setting; start typing the 
<value> immediately after 
the equal sign

• for settings that turn a feature 
on or off, the <value> should 
be either ON or OFF

• you can include comments 
within the file but you must 
begin each comment line with 
a semicolon (;)
Changing the Settings
When the msim.ini  file is created (during installation), it 
assigns default values to the settings. Most of the settings ca
changed through dialog boxes within Schematics or Probe. 
However, some settings may only be modified with a text edi

Note If a text editor is used to modify settings, MicroSim 
applications should not be running at the time you make 
modifications. Changes made to msim.ini through a 
text editor should be saved to the file; they will take 
effect the next time the program is started.

You can change the default settings using any text editor, fo
example, Notepad.

MSIM.INI Sections
The following sections provide information on the elements 
within the sections in msim.ini and will give you details on 
the permissible <keyword> and <value> settings.

Refer to the Schematics User’s Guide for instructions on 
changing the settings which can be configured within 
Schematics dialogs. Refer to Probe Help for information on 
Probe commands.

Note Many items will not appear in msim.ini  unless the 
default values have been changed.
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Use a text editor to edit this 
command line option.

Use a text editor to edit this 
command line option.

Edit this command line option 
from within Schematics.
[MicroSim] Section
The [MICROSIM] Section contains settings that are shared 
Schematics, the simulator, and other programs.

When changing command line options from Schematics, do 
following:

1 Select Editor Configuration from the Options menu.

2 Click the App Settings button in the Editor Configuration
dialog box.

BACKUP

Specifies the directory in which backup copies are to be plac
The default is set at installation. This line can be edited in th
form:

backup=<directory>

where <directory> specifies the directory where backups will b
written. If you are installing a network version, this directory 
cannot be write-protected and should be set to a local direct
not a network directory.

EDITOR

Specifies the text editor to use for browsing the netlist and 
output files.  This line can be edited in the form:

editor=<editor name> %f

where <editor name> specifies the text editor and %f specifies
where the file name will be substituted in the command line. T
default text editor is Textedit.

LIBPATH

Specifies the directories where the Model, Symbol, and Pack
Libraries are located. See LIBPATH on page 3-7.
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Edit this command line option 
from within Schematics.

Edit this command line option 
from within Schematics.

Edit this command line option 
from within Schematics.

Use a text editor to edit this 
command line option.
OPTIMIZERCMD

Specifies the command used to run PSpice Optimizer. This l
can be edited in the form:

OPTIMIZERCMD=<optimizer> [options]*

where <optimizer> indicates the executable and [options] can be 
any of the available PSpice Optimizer switches. 

PLSYNCMD

Specifies the command that starts PLSyn. The default is 
PLSYN. This line can be edited in the form:

PLSYNCMD=<plsyn>[options]*

where <plsyn> indicates the executable for starting PLSyn, a
[options] can be any of the available PLSyn switches.

PLOGICCMD

Specifies the command that starts PLogic. This line can be 
edited in the form:

PLOGICCMD=<plogic>[options]*

where <plogic> indicates the executable for starting PLogic, a
[options] can be any of the available PLogic switches.

PARTSCMD

Specifies the command used to run Parts. This line can be ed
in the form:

PARTSCMD=<parts> [options]*

where <parts> indicates the executable and [options] can be any 
of the available Parts switches.
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Edit this command line option 
from Schematics

Edit this command line option 
from Schematics

Use a text editor to edit this 
command line option.

Note SECURITYPORT in the 
msim.ini file is only for serial 
plugs. All parallel ports will be 
scanned; there is no way to 
specify which port the plug is in.

Edit this command line option 
from within Schematics.
PROBECMD

Specifies the command to run Probe.  This line can be edite
the form:

PROBECMD=<probe>[options]*

where <probe> indicates the executable for starting Probe, 
[options] can be any of the available Probe switches.

PSPICECMD

Specifies the command used to run PSpice. This line can be
edited in the form:

PSPICECMD=<pspice> [options]*

where <pspice> indicates the executable for starting PSpice,
[options] can be any of the available PSpice switches.

SECURITYPORT

Specifies the COM port on which the serial security plug is 
installed  This line can be edited in the form:

securityport=<COMn>

where <n>  is the COM port number on which the security plu
is installed, (COM1, COM2, COM3, or COM4).  If no port is 
specified (the default) then all ports are checked.

Use text editor.

STMEDCMD

Specifies the command used to run StmEd. The default is 
STMED.

STMED=<stmed>[options]*

where <stmed> indicates the executable for starting the 
Stimulus Editor, and [options] can be any of the available Probe
switches.
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LIBPATH
This variable originally gets set during installation to the 
directory in which the library files are installed. For example,
you install the programs in the directory c:\msim, the LIBPAT
variable will be set to:

LIBPATH=c:\msim\lib 

If you install Microsim applications into another directory, the
a lib subdirectory will be created under your named director
For example, if you specify c:\mydir as the directory where 
Schematics is to be installed, then your LIBPATH variable w
be set to:

LIBPATH=c:\mydir\lib

More than one directory can be specified for LIBPATH by 
separating the paths with a semicolon (;). When a library file
referenced, Schematics will search for the file in the director
in the order specified by this variable. You can change the 
LIBPATH variable by editing this line in the form:

LIBPATH=<directory>[;<directory>]*

For example, if you want Schematics to search for Symbol 
Library files in more than one place you could set the variable 
to:

LIBPATH=c:\msim\lib;d:\diodes

In this case, Schematics will first look for a library file in 
c:\msim\lib. If it finds the specified library file, it will stop 
searching. Otherwise, it will look in the next directory, 
d:\diodes.

Command line options for MicroSim applications are explain
in the PSpice A/D Reference Manual. 
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[MICROSIM Options] Section
The [MICROSIM OPTIONS] section specifies which 
MicroSim application and features are available. These setti
are used by applications, such as Schematics, to determine
which optional menu commands and dialogs used to interfac
other programs should be made available.

*  Set during installation.

Keyword Description*

ANALOG Enables/disables the interface for analog 
simulation (PSpice or PSpice A/D). Default: 
OFF.

DIGITAL Enables/disables the interface for digital 
simulation (PSpice A/D or PLogic). Default: 
OFF.

DIGITALTIMING Enables/disables the interface for digital timing 
simulation (PSpice A/D or PLogic). Default: 
OFF.

MONTECARLO Enables/disables the interface for PSpice 
Monte-Carlo simulation. Default: OFF.

OPTIMIZER Enables/disables the interface to the PSpice 
Optimizer. Default: OFF.

PACKAGETYPE Specifies which package the user has 
purchased: Schematics, Basics, Basics+, 
MicroSim, AMD Standard, AMD Advanced. 
Default: MicroSim

PARTS Enables/disables the interface to Parts. Defaul
OFF.

PCBOARDS Enables/disables the interface to PCBoards. 
Default: OFF.

PLSYN Enables/disables the interface to PLSyn. 
Default: OFF.

PROBE Enables/disables the interface to Probe. 
Default: OFF.

SIMULATION Enables/disables the interface for Schematics 
simulation. Default: OFF.

STMED Enables/disables the interface to StmEd. 
Default: OFF.
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[PARTS Libs] Section
The [PARTS LIBS] section lists the Symbol and Package 
Library files that are available to the schematic editor:

1  Select Editor Configuration from the Options menu.

2 Click the Library Settings button in the Editor 
Configuration dialog box to display the Library Setting 
dialog for entry of new library files. 

You can also edit the “msim.ini” file directly to add entries in th
form:

LIB<n>=<file name> [<symbol library extension>, 
<package library extension>]

where <n> is the number of the library file in ascending order 
the list, <file name> is the name of the Symbol and Package 
Library file, <symbol library extension> specifies the extension
of the Symbol Library file, and <package library extension> 
specifies the extension of the Package Library file. For exam

IB1=bipolar [.slb, .plb]

loads the Symbol Library file “bipolar.slb” and the Package 
Library file “bipolar.plb.” If the extension is omitted, the 
Symbol or Package Library file will not be loaded. For examp

LIB1=analog [.slb]

would load only the Symbol Library file “analog.slb” and not 
the Package Library file of the same name. 

Note The LIB<n> statements must be in ascending order with 
no gaps in numbering.  

Keyword Description

LIB1=

LIB2 =

LIB3=

.

.

.

LIBn=

List of all the Symbol and Package Library file names that 
will be used by Schematics.  If you have user-defined 
Symbol or Package Library files, you will need to add your
file names to this list.  
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[Probe] Section
The [PROBE] section defines the configuration settings used
Probe.

Keyword Description

AUTOUPDATEINTERVAL Controls the update interval for Probe 
waveforms.  Options are Auto, Seconds, 
or Percent.   The default is AUTO. 

AUTOUPDATEPERCENT Specifies the auto update interval for 
Probe waveforms in percent, if 
AUTOUPDATEINTERVAL is set to Percent.  
The default is 10.

AUTOUPDATESECONDS Specifies the auto update interval for 
Probe waveforms in seconds, if 
AUTOUPDATEINTERVAL is set to 
Seconds.  The default is 10.

CURSORBOTTOM Specifies the bottom position of the 
cursor box.  The default is 0.

CURSORRIGHT Specifies the right position of the cursor 
box.  The default is 0.

DGTLNAMELEFTJUSTIFY Controls whether digital trace names are 
left justified or right justified.  Valid 
settings are ON and OFF.  The default is 
OFF, right justified.

DISPLAYEVALON Turns on the display of traces and 
marked points used by Display 
Evaluation in the currently selected plot, 
on the currently selected Y axis.  The 
default is OFF.

HISTNDIVISIONS Specifies the number of divisions for 
histograms.  The default is 10 divisions.

HISTSHOWSTATSON Specifies that the histogram statistics 
will be displayed in the Probe window.  
The default is ON.

LASTFILEn Specifies up to four of the most recently 
used files. This should not be changed by 
the user.

MARKDATAPOINTS Specifies whether data points will be 
marked on Probe traces.  This option can
be set on or off.  The default is OFF.
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PRBFILE Specifies the name of a “.prb” file which 
contains Probe macro, display, and goal 
function definitions.

PRBFILE = <filename>.prb

PRINTERLINEWIDTH Specifies the width of lines drawn during 
printing (in pixels).  The default is 1.

SCROLLBARS Controls display of scroll bars for 
Probe.  Options are Always, Never, or 
Auto.  The default is AUTO.

STATUSLINEON Turns the status line in Probe on or off.  
The default is ON.

TRACECOLORSCHEME Specifies the trace coloring scheme.  
This option can be set to Normal, Match, 
or Sequential.  The default is NORMAL.

TRACESYMBOLS Specifies how trace symbols will appear 
on traces in the Probe plot window.  This 
option can be set to Always, Never, or 
Auto.  The default is AUTO.

Keyword Description
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[Probe Display Colors] Section
To change the settings in the [PROBE DISPLAY COLORS] 
Section, use the format:

<item name>=<color>

where <item name> specifies the Probe item and <color> 
specifies the color.  

For example, the entry FOREGROUND=DARKGREEN 
results in graph axes being drawn in dark green.  Or, 
BACKGROUND=CYAN results in the screen background 
changing to the color cyan instead of the default color black

Alternatively, you may specify varying degrees of color by 
using the R, G, B (red, green, blue) value of the color. For 
example, TRACE_2=255 0 0 is the same as TRACE_2=RE

The available colors are: black, blue, brown, brightwhite, cya
darkblue, darkcyan, darkgray, darkgreen, darkmagenta, dark
green, lightgray, magenta, red, and yellow.

In some cases you may want to limit the number of colors us
for drawing. The default and maximum number of colors is 
twelve.

Keyword Description

BACKGROUND Specifies the background color. 
Default: Black.

FOREGROUND Specifies the foreground color. 
Default: White.

NUMTRACECOLORS Specifies the number of trace colors. The 
default is six. This line can be edited in the 
form:

numtracecolors=<n>

where <n> specifies the number of trace colors,
before it starts repeating back to the 1st trace 
color.

TRACE_1 Specifies the color of the first trace.
Default: BrightGreen.

TRACE_2 Specifies the color of the second trace. Defaul
BrightRed.
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TRACE_3 Specifies the color of the third trace. 

Default: BrightBlue.

TRACE_4 Specifies the color of the fourth trace. Default:
BrightYellow.

TRACE_5 Specifies the color of the fifth trace. 
Default: BrightMagenta.

TRACE_6 Specifies the color of the sixth trace. Default: 
BrightCyan.

TRACE_7 Specifies the color of the seventh trace. Defau
Mustard.

TRACE_8 Specifies the color of the eighth trace. Default
Pink.

TRACE_9 Specifies the color of the ninth trace. Default: 
Lightgreen.

TRACE_10 Specifies the color of the tenth trace. Default: 
Darkpink.

TRACE_11 Specifies the color of the eleventh trace. 
Default: Lightblue.

TRACE_12 Specifies the color of the twelfth trace.   
Default: Purple.

Keyword Description
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[Probe Printer Colors] Section
To change the settings in the [PROBE PRINTER COLORS]
section, use the format:

<item name>=<color>

where <item name> specifies the Probe item and <color> 
specifies the color to be printed on the page.

For example, the entry FOREGROUND=DARKGREEN 
results in graph axes being printed in dark green. The default 
maximum number of colors is twelve. If, however, you are usi
a four pen plotter, you might want to set the maximum numb
of colors to three. The first three trace colors will be used for t
colors of digital traces.

 Keyword Description

BACKGROUND Specifies the background color. 
Default: White.

FOREGROUND Specifies the foreground color. Default: Black

NUMTRACECOLORS Specifies the number of trace colors.  The 
default is 6.  This line can be edited in the form

numtracecolors=<n>

where <n> specifies the number of trace colors,
before it starts repeating back to the 1st trace 
color.

TRACE_1 Specifies the color of the first trace. Default: 
Green.

TRACE_2 Specifies the color of the second trace. Defaul
Red.

TRACE_3 Specifies the color of the third trace. 

Default: Blue.

TRACE_4 Specifies the color of the fourth trace. Default:
Yellow.

TRACE_5 Specifies the color of the fifth trace. Default: 
Magenta.

TRACE_6 Specifies the color of the sixth trace. Default: 
Cyan.

TRACE_7 Specifies the color of the seventh trace. Defau
Mustard.
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[Schematics Border], [Probe 
Border], and 
[PSpice Border] Sections
Note These items should not be changed.

These sections define the window size and position that will
used when the respective program is started. The items in t
section are: ZOOMED, LEFT, TOP WIDTH, and HEIGHT. 

[Printer Configuration] Section
The [PRINTER CONFIGURATION] section contains the 
configuration settings for the printer setup. Modify the defau
settings through the Printer Setup option in the File menu. 

TRACE_8 Specifies the color of the eighth trace. Default
Pink.

TRACE_9 Specifies the color of the ninth trace. 

Default: Lightgreen.

TRACE_10 Specifies the color of the tenth trace. Default: 
Darkpink.

TRACE_11 Specifies the color of the eleventh trace. 
Default: Lightblue.

TRACE_12 Specifies the color of the twelfth trace.   
Default: Purple.

Keyword Description
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